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Cursul are in vedere montajul de film utilizand programul de editare Final Cut Pro X.
Teme si problematici vizate:

1. Caracterizarea imaginii statice in antiteza cu imaginea dinamica.

a. Identificdm puncte comune intre cele doua tipologii de imagine:

- in primul rand ambele sunt imagini, iar imaginea este un limbaj universal;

- ambele se inscriu intr-un cadru stabil, de regula dreptunghiular.

Caracterul universal al imaginii a fost constientizat timpuriu. Frescele sau reprezentarile scenelor biblice au
o0 compunere pe cadre care este similara storyboard-ului, dupa cum precizeaza Bill Viola intr-unul dintre
interviurile sale (https://www.youtube.com/watch?v=GQuSYsFMMt4). in cazul frescelor avem o suprafata
mare - peretii bisericii, impartita in cadre/scene, deci avem o segmentare a unei suprafete mari in mai
multe cadre de dimensiuni mai mici, in timp ce in cazul imaginii dinamice avem un cadru stabil, fix in care
se succed multiple secvente de imagini. in cazul frescelor, fiecare scend poate fi de sine statitoare, in timp
ce se constituie ca ansamblu si sunt citite ca atare. In cazul imaginii dinamice fotogramele de cele mai
multe ori nu sunt de sine stdtatoare ci se afla intr-o relatie determinanta unele cu celelalte, nu pot fi citite
dintr-o singura privire ca un ansamblu, ci po fi vizionate intr-o desfdsurare succesiva pe o anumita durata
de timp.

Daca am amintit de imaginea statica care contine multiple module, putem aminti in acest context si de
serializari, care asemenea imaginilor dinamice sunt compuse dintr-un numar mai mare de imagini (imagine
statica serializata - module, imagine dinamica - fotograme, medalioane).

Bill Viola creeaza filme ce tind mai degraba spre o expresie statica. il mentionam pentru ca se afla cumva la
intersectia celor doua tipologii de imagini - statice si dinamice, atat prin forma de reprezentare a creatiilor
sale cat si prin citarea si inspirarea din lucrari de pictura. Exemplul cel mai laindemana il constituie video-ul
intitulat Emergence realizat in anul 2002 reprezentand un citat dupa o fresca din anul 1400 realizata de
Masolino da Panicale.

Masolino da Panicale - Pieta, c. 1424

fotograma extrasa din video-ul Emergence, Bill Viola, 2002

Corelarea picturii cu forma alternativa de arta reprezinta preocuparea fundamentala a lui Bill Viola, dar si a
altor artisti sau regizori contemporani si nu numai, cum sunt Peter Greenaway (Nightwatching, Rembrandt
j'acusse, Goltzius and the Pelican Company, etc.), Sam Taylor-Johnson (seria Natura moarta), Andrei
Tarkovski, s. a.

In cazul celor amintiti se poate observa o atentie deosebita acordata elementelor de limbaj ale imaginii
- compozitiei, cantitatilor tonale, etc., principiile gramaticale ale imaginii statice fiind utilizate in
cunostinta de cauza in cadrul gandirii/construirii acestor imagini dinamice. Daca ne raportam la acelasi
cadru dreptunghiular, dupa cum am amintit mai sus, si in cazul imaginilor statice dar si al celor in miscare,
principiile de compunere ale unui cadru dintr-un film sunt stabilite cu mult inainte de aparitia acestui
limbaj de catre imaginile statice, ambele tipologii de imagini fiind pana la urma viziuni transfigurate in
acelasi cadru fix si stabil, dar prin limbaje vizuale diferite.

b. Identificdam caracteristicile imaginii dinamice in antiteza cu imaginea statica:
- durata

- miscare

- compusa din multiple imagini statice (fotograme)

- sunet

In cazul imaginilor dinamice este inserata durata in spatiu, caracteristica fundamentala a video-ului fiind
durata. Filmul este compus din imagini statice, standard de 24 de fotograme pe secundd, dar care poate
ajunge la un numar mult mai mare de fotograme pe secunda. Miscarea este creata tocmai prin aceasta
succesiune rapida a fotogramelor. Vizualizarea structurii filmului (a suitei de fortograme) este necesar3,
realizandu-se astfel trecerea de la imaginea statica (cu care s-a operat pana in semestrul I) la cea dinamica.
In contextul actual al evolutiei mediilor digitale, este necesara o stapanire a noilor mijloace cu scopul de a
fi utilizate ca instrumente de lucru in creatia artistica si totodata de cunoastere a limbajului vizual.
Totodata consideram ca trebuie constientizate aspectelelegate de schimbarea nouluimodel de comunicare,
de implicatiile pe care le are aceasta schimbare in creatia artistica.

Link-uri:

https://www.youtube.com/watch?v=RTPf6mHKYDO
https://www.youtube.com/watch?v=auFBt4JBHHI
https://www.youtube.com/watch?v=hx5Cu7U-Fkg
http://samtaylorjohnson.com/moving-image/art/still-life-2001
https://www.youtube.com/watch?v=i0vA3WZFMKA

: https://www.youtube.com/watch?v=FYKZif9o0xs

2. Notiuni de baza care vizeaza partea tehnica (NLE, Container, Codec, Compresie, Randare)
a.NLE = NON-LINEAR EDITING SYSTEM

Editarea non-destructiva este o forma de editare a imaginii, a sunetului sau a video-ului astfel incat
materialul original rdamane nemodificat in urma editarii.

Editarile efectuate in cazul unui video raman inregistrate sub forma unei liste EDL (edit decision list), astfel
de fiecare data cand accesam un video editat acesta este reconstruit in timp real din materialul original si
pasii editarii specificati.

Denumirea este in contrast cu metodele de editare lineara a filmului din secolul al XX-lea.

https://books.google.ro/books?id=A8QgBgAAQBAJ&pg=PA12&Ipg=PA12&dqg=nonlinear+system+edit-
ing&source=bl&ots=UnGGtgv4DC&sig=ACfU3UOXPdMY11V7VBzL5PwBSjMuP4_v0Q&hl=ro&sa=X-
&ved=2ahUKEwjegrvc-5boAhULt4sKHXZIDmgQ6AEWEHOECAsQAQ#v=onepage&qg=nonlinear%20sys-
tem%20editing&f=false



9, LE NLE

Linear film editing Non-linear editing system

* Toate fisierele (materialul original)
sunt pe hard disk sau servere video;

* Inregistrari pe role de film sau casete;

* Nu permite vizualizarea directa a unui
anumit moment din film, facdnd necesara
vizualizarea lineara a inregistrarii pentru a
ajunge la cel dorit;

* Ofera posibilitatea de a accesa in
mod direct orice fotograma;

* Metadata este atasat clipuluiin
mod automat (timecode, numele

clipului, localizare etc.);

* Similar metodelor si tehnicilor IT
de cut and paste, dar fara actul
destructiv al taierii, fara sa fie

eliminate portiuni.

* Taierea filmului este ireversibila.

Final Cut Pro este un program de editare non-linear care permite si faciliteaza organizarea, vizionarea si
editarea filmului.

b. CONTAINERS
Containers este o procedura sau un algoritm utilizat in stocarea mai multor fisiere sau date. Algoritmul

precizeaza modul in care informatiile sunt “impachetate” impreuna intr-un singur fisier care le contine.
De obicei extensia fisierului filmului face referire la container. Enumeram cateva exemple:
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- Audio Video Interleave (.avi) - dezvoltat de Microsoft si lansat cu Windows 3.1.
- QuickTime (.mov or .qt) — dezvoltat de Apple, suporta o varietate mare de codecs.

- M4V si .MP4 - .m4v si . mp4 sunt similare si ambele sunt parte a MPEG-4 care se bazeaza pe formatul
fisierului Quicktime. .m4v a fost creat de Apple ca o extensie a MPEG-4 si este citibil de Apple, alte device-
uri nu prea recunosc acest container. MP4 este un format recunoscut de multe utilitare, putand fi redat atat
pe PC cat si pe Mac.

c. COMPRESIA VIDEO

Compresia presupune procesul prin care un film poate fi micsorat.

Compresia duce la micsorarea unuifilm (ex. de la 70 GB la 70 MB), dar cu pierderi legate de calitatea imaginii.
Diferiti algoritmi de compresie balanseaza in mod diferit relatia dintre marime si calitate.
(https://tehnocultura.ro/2014/08/14/ce-este-compresia-video/)

Modalitati de compresie:

Compresie spatiala Compresie temporala
sau sau
intraframe interframe

» compresie in interiorul fiecarui cadru » compresie intre cadrele filmului

* Procedeu prin care se interpun cadre de
calitate mica intre cadre de calitate mare
(MPEG sau Motion JPEG)

» are rolul de a comprima informatia
dintr-o imagine (ex. codecul JPEG, Joint
Photographic Expert Group)

* Compresia ca proces este o metoda prin
care se urmaresc pixelii care nu se
schimba de la o fotograma la alta sau care
se repeta de mai multe ori in acelasi
cadru.

d. CODECS

Codecs reprezinta o metoda de a coda si decoda date, mai specific, date compresate. Termenul de codec
a devenit unul generic, dar provine de fapt din forma prescurtata a compresorului. De fapt, codec-ul preia
date digitale si le compreseaza (pt. transport sau stocare) sau le decompreseaza (pt. a putea fi vizualizate
sau a fi transcodate).

h.264 — este un codec foarte utilizat pentru camerele video digitale, avand container-ul AVCHD.

Modificarea formatului
in momentul de fata sunt disponibile un numar atat de mare de codec-uri si containers incat este destul de
dificil sa ne asiguram ca video-ul creat poate fi vizionat de catre oricine, pe orice device cu orice software.
In aceasta situatie recomandam utilizarea variatiilor codec-ului H.264 si container-elor MP4.
Este relativ simplu sa convertim formatele video cu un numar mare de utilitare gratuite sau ieftine care
se gdsesc pe Internet. Totusi este important de retinut faptul ca atunci cand transferdm formatele, re-
compresia cauzeaza degradare. In aceasta situatie este bine sa arhivam originalele, pentru a pastra si o
varianta de o calitate mai buna.

Totodatad, daca schimbam containers-ul, unele date (cum sunt titlurile, subtitrarile etc.) pot fi pierdute daca
noul container nu le poate suporta. (https://www.techsmith.com/blog/understanding-video-file-types-co-
decs-containers-and-outputs/)

e. RANDAREA

Randarea este un proces prin care calculatorul proceseaza informatia dintr-o sursa de date si utilizeaza
acea informatie pentru a produce si reda imaginea.

Termenul de randare este utilizat in editarea video pentru a descrie procesul care se desfasoara pe o
anumita durata de timp pentru ca imaginile prelucrate sa poata fi vizionate in timp real.

In FCP X randarea video-ului are loc in “fundal’, ceea ce permite continuarea editarii in timpul randarii.

In FCP 7 in timpul randarii nu se poate edita. Pentru a putea vizualiza in Canvas modificarile efectuate pe
un anumit clip, acesta necesita randare. Durata randarii creste o data cu complexitatea editdrilor efectuate.



(audio-ul dureaza mai putin fata de randarea video-ului; daca avem una sau mai multe clip-uri suprapuse
creste si durata randarii, complexitatea fiind mai ridicata in acest caz).

Final Cut Pro poate reda multiple formate media si ofera posibilitatea de a transcoda media (prin conversia
intr-un format diferit sau prin modificarea setarilor ei) pentru a o face potrivita pentru editare.

B >80

General Editing Playback Import Destinations

Import

Fisiere media proxy sau optimizate

Crearea mediei optimizate ) Crearea mediei proxy

Aceasta optiune creeaza fisiere video
si imagini statice proxy. Video-ul este
transcodat Tn codec-ul Apple ProRes
422 Proxy.

Aceasta optiune transcrie video-ul cu
codec-ul Apple ProRes 422, ceea ce ofera o
performanta mai buna in momentul
editarii, durata de randare mai rapida si o
calitate mai buna a culorii. Daca formatul
initial poate fi editat la o performanta
buna, atunci aceasta optiune este anulata.

FCP creeaza versiuni proxy la o
calitate medie (1/2 rezolutie) ceea ce
creste performanta editarii si scade
marimea fisierelor fata de cele
optimizate.

Imaginile statice sunt transcrise in
fisiere JPEG sau PNG, facand procesul
de editare si randare mult mai rapid,
in special in cazul in care imaginile
originale sunt foarte mari.




3. Interfata - Importare clip/inregistrare - Organizare - Vizualizare clip sursa - Markers

a. FCP interfata
b. Organizarea elementelor unui proiect
c.Vizionarea materialului sursa

Final Gut Pro Trial _ File [ﬂll Tim Mark Cip Modity View Window Help

Editing

Interfata Final Cut Pro X
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ihh' Cut Pro 7 - Final Cut Pra X

Programele de editare non-lineare preiau principiile de baza utilizate in editarea filmului de tip analog
(operatia de taiere - cut etc.). Interfetele (structura lor) si metodele de lucru din diferitele soft-uri de editare
existente sunt similare.
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Sidebar: Organize libraries Browser: Skim and 0 .
and access photos, audio, select clips to use Viewer: Play back rga nizare
titles, and generators. Iin your projects. clips and projects.
Library Library Library Library
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Clip Clip Clip Clip Clip Project Project Project Project

FCP X file structure

Media Projects Events __..--""Librarie;\\ .
FCP X

Slidebar - locul/ spatiul in care se organizeazi toate elementele proiectului care se utilizeaza in editare Houses ”Ed'a
(biblioteci, accesare fotografii, fisiere audio, titluri). and Projects Houses Events

Magnetic Timeline:
Edit your movie in this area.

Browser — spatiul in care se vizualizeaza si selecteaza clipuri pentru a le utiliza in proiecte.

Viewer - spatiul in care se vizualizeaza clipurile si proiectele.

Timeline - reprezentarea grafica a tuturor deciziilor care se fac in momentul editarii. Reprezinta “paleta” de I_I b ra r'y M O d e I

lucru unde se editezeza materialul, se muta, taie, ajusteaza etc.

Importarea unui clip:

Library (bibliotecd) = baza de date care contine media. !
Toata media importata in evenimentul bibliotecii este valabila pentru toate proiectele din FCP X. EJ . | = ! a a

DERE 2R
DRE 2R

Events Media & Projects




Fisierele media

- reprezinta materialul prim pe care-| utilizam in crearea unui proiect;
- poate fi video, audio sau imagine statica;

- pot contine multiple componente audio si video.

Clipurile

- reprezinta media cu care operezi, dar nu sunt fisierele media in sine;

- clipurile dintr-un proiect indica (sunt legate de) fisierele media sursa de pe hard sau alt device de stocare;
- atunci cand modifici un clip, nu modifici fisierul media, ci doar informatia clipului in acel proiect (editare
non-destructiva).

- decupajele sau stergerile unor portiuni ale clipului sunt produse doar la nivelul proiectului, nu si la nivelul
fisierelor media sursa aflate pe hard sau a celor din biblioteca media (library).

Organizare -> Copy files to Final Cut Events folder: dacd bifam aceastd casuta atunci media originald va fi
copiata intr-un folder Event pe hard drive-ul tau.

-> Import folders as Keyword Collection: daca bifam atunci orice clip din folderele pe care le
importi vor primi denumirea folderului ca pe un cuvant cheie ce poate fi cautat.

Import
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General Editing Playback Import Destinations
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Modalitati de vizionare a clipului importat utilizand shortcut-urile J K L.

Markers (Standard markers, Chapter markers, To-do items, Completed to-do intems)

- puncte de referinta care pot fi plasate pe clip pentru a localiza, identifica si naviga la fotogramele
specificate;

- note legate de editare sau alte informatii descriptive etc.

4, Proces de lucru - Timeline - adaugarea clipurilor in timeline - In and Out Points - Append - Insert -
Overwrite - Three-point editing

a. Proces de lucru:

- vizionarea materialului brut si selectarea portiunilor dorite pentru a fi editate;
- inserarea clipurilor in timeline pt. editare;

- aranjarea clipurilor;

- finisarea taierilor/ editarilor.

b. Timeline:

- reprezentarea grafica a clipurilor video si audio;
- portiunea in care se editeaza;

- Primary storyline in Final Cut Pro X.

Timeline in FCP X

¢. In and Out Points

- permit definirea unei anumite portiuni a clipului sau secventei pentru a fi editatd, stearsa, copiata etc.

- In point -> marcheaza prima fotograma a clipului care urmeaza sa fie editat intr-o secventa.

- Out point -> specifica ultima fotograma a portiunii de clip alese.

Portiunea de dinainte si de dupa In si Out points se numesc handles (manere). Acestea reprezinta media
aditionald pe care nu o folosim in acest moment pentru editare, dar care poate fi necesara daca dorim sa
0 adaugam ulterior.

In si Out Points se utilizeza in Browser (FCP X) pentru a selecta portiunea/ portiuni din materialul original
pe care dorim sa le editam.

In si Out Points pot fi utilizate si pentru o editare in 3 puncte (three-point editing).



d. Modalitati de adaugaugare a clipurilor in timeline
- Drag-and-drop editing

Zoom in Timeline

Adaugare sau inserare?

o e Zoom in: View > Zoom in (cmd +)
* Append clip (ad3ugare)

* Choose Edit -> Append clip to Storyline (E) * Zoom out: View >Zoom out (cmd -)
e /7
Alt/option click (to zoom out) JETE
<> Trim

Index ) Position

d:l; Range Selection

5% Blade
Q, Zoom
W Hand

* Insert clip (inserare clip)

e Edit > Insert (W) —
N N Zoom to fit

Before edit

provon * View > Zoom to Fit (Shift-Z)

Index

Before choosing Zoom to Fit

Comenzi rapide (shortcuts)
Adaugare (Append) clip E
Inserare (Insert) clip W
Suprascriere (overwrite) clip D

b oy oy S

TSl S S S0 3 W T

After choosing Zoom to Fit



Zoom slider

* Click the clip Appeareance button

e. Magnetic timeline FCP X

Mentine in mod automat conexiunea si sincronizarea atunci cand adaugam un clip in timeline, mutand
clipurile existente din calea celui nou.

Position tool — pentru a demagnetiza clipurile, astfel incat sa putem sa-l pozitionam pe cel nou oriunde in
cronologie, indiferent de pozitia clipurilor deja existente.

Stergerea clipurilor din timeline.

f. Three-point editing
Ne permite utilizarea punctelor de inceput (start) si sfarsit (end) atat in Browser cat si in Timeline pentru a
specifica durata unui clip si locul plasarii acestuia in Timeline.
Doar 3 puncte sunt necesare pentru a fi determinata portiunea clipului sursa si locul destinatiei lui in
Timeline. FCP deduce in mod automat cel de-al 4-lea punct.
Cele 3 puncte alese pot fi in urmatorul mod: 2 x In + 1 Out
sau
2xOut+1In.

Urmatoarelor modalitati de editare li se potriveste utilizarea editarii in 3 puncte:
- Insert (inserare)

- Connect (conectare)

- Overwrite (suprascriere)

Pasi necesari:

1. Stabilirea punctelor In si Out in Browser (FCP X) pentru a specifica portiunea pe care dorim sa o
introducem in Timeline, apoi in Timeline putem stabili locul clipului, determinand inceputul lui (prin In sau
prin pozitionarea playhead-ului).

2. Stabilirea punctelor de editare intr-un Storyline din Timeline. Determina prin In si Out pozitia in care
vrei sa plasezi clipul. Aceste puncte vor determina durata clipului, fara sa tina cont de durata clipului din
Browser.

5. Unelte FCP (FCP tools)

a. Unelte de vizionare

b. Unelte de selectie

¢. Unelte de editare

d. Unelte de modificare a imaginii
e. Keyframe tools

Modalitati de editare utilizand unelte, ajustarea clipurilor din timeline, unelte de editare;
Ripple, Roll, Slip, Slide

» Ripple edit

Scurtarea sau extinderea unui clip, prin ajustarea punctelor In si Out in proiect sau secventa.
Tipologia de taiere prestabilita in FCP este ripple edit - editare care ajusteaza punctul de inceput sau
sfarsit al unui clip astfel incat sa nu ramana goluri (gaps) in Timeline.

Modificarea duratei clipului se petrece in exterior, mutand urmatoarele clipuri mai devreme sau mai
tarziu in timeline.

Before edit

After edit



Ripple edit in FCP X: Select tool > drag edit points » Slip edit

Trim edit tool - Nu modifica durata clipului din timeline;
- Nu modifica pozitia clipului din timeline;
- Modifica continutul media a clipului aflat in timeline;
- Permite modificarea simultana a punctelor In si Out.

k Select
<[> Trim

P, Posttion 00:00:10:00 00:00:30:00
4:‘; Range Selection | |

5= Blade
- A B C

W Hand Before edit

00:00|:17:OO OO:OOI:37:OO

» Roll edit _

Ce face?
Ajusteaza in mod simultan punctul de pornire al unui clip si sfarsitul unui clip adiacent. After edit

Cand o utilizam?

Daca ne convine pozitia clipurilor in timeline, dar dorim sa modificam taieturile.

* Nici un alt clip din proiect/secventa nu va fi modificat

Durata intregii secvente/ a intregului proiect ramane aceeasi, dar ambele clipuri isi modifica durata. Unul
devine mai lung, iar celalalt mai scurt, pentru a compensa.

Utilizam Trim tool
+ ... (durata) sau - ..... (durata), pentru a addauga sau a substrage din editarea curentd, apoi apasam Enter.
Trim Start sau option [

Trim End sau option ] Pentru a putea realiza aceasta editare clipul trebuie sa aiba manere (handles) in ambele capete.
Trim to Playhead option \

Nudge Left,
Nudge Right.

Before edit

After edit




» Slide edit (Option-drag - Trim tool) 5. Modificarea vitezei clipurilor din Timeline (UNIFORM/CONSTANT sau VARIABIL)

- Schimba pozitia unui clip aflat intre alte doua clipuri fara sa rdmana goluri. 100 % - viteza normala
- Continutul si durata clipului raman neschimbate, doar pozitia lui in timeline se modifica. > 100 % - clipul se va derula mai rapid
- Unul dintre clipurile adiacente devine mai scurt, iar celalalt mai lung. < 100 % - slow motion

- Durata totala a celor 3 clipuri nu se modifica si nici al intregului proiect.
Retime (Cmd R)
Custom Speed (Ctrl + Alt/Option + R)

Before edit https://www.youtube.com/watch?v=A0Nk82-ARVQ

6. Redimensionarea cadrului - utilizarea medalioanelor ca metoda de compunere
8. Tranzitii
After edit 9. Efecte - modificarea raporturilor tonale, cromatice ale clip-urilor

10. Freeze frame + extargere de fotograme
11. Inserare de text in video

Precision editor (editor de precizie) 12. Export

Utilizand acest editor, putem realiza o ajustare precisa a punctelor de editare dintre doua clipuri din Cursul are in vedere, pe langa asimilarea notiunilor tehnice legate de editare, vizionarea unor filme de
Timeline, prin oferirea unei vizualizari extinse a ambelor clipuri, cat si a portiunilor neutilizate a fiecarui clip. arta consacrate. Fiecare student realizeaza in timpul acestui semestru un video de maxim 3 min., prin care
Se poate tdia/ decupa (trim) sau extinde sfarsitul unui clip si inceputul urmatorului clip impreund sau dobandeste cunostinte tehnice dar si cunostinte legate de gramatica imaginii.

separat.

In momentul decupajului, se poate viziona in Viewer, in doua ferestre, modificarile efectuate.

Ripple Roll

—_— s :
| | ] D |
 G— i = d o
— «—
scurteaza sau extinde clipul - scurteaza si extinde - modifica continutul - modifica pozitia clipului
. 2 clipuri simultan . clipului folosindu-se de - in timeline fara a lasa
(unul este scurtat, - manerele sale " goluri

celalalt extins)

https://vimeo.com/28318086



